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The StepWatch™ Activity Monitor is an ankle-worn ambulatory activity monitor. The  
StepWatch™ is attached to a person’s ankle by means of a Velcro strap or cuff. The 
StepWatch™ works with a docking station and software for programming and 
downloading data and displaying and analyzing the data. You will need a computer 
running either a Windows Vista+ or Mac OS X 10.7+ operating system for version 3.4. 
Older versions of Windows and OS X are supported under a previous software version 
3.1b. 
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I .  General StepWatch™ Information and Care 
The StepWatch™ Activity Monitor (US Patent # 5,485,402) is a research and clinical 
tool for long-term assessment of ambulatory function in a home setting. It is an ankle-
worn, microprocessor-controlled step counter which unobtrusively measures how 
mobile a person is throughout daily life. Step counts can be recorded for up to 50 
days between downloads, depending upon the activity level of the individual subject. 
For example, if a subject takes tens of thousands of steps every day, it is possible to 
exhaust the memory of the StepWatch™ before 50 days has elapsed.  
 
The StepWatch™ Activity Monitor detects steps for a wide variety of normal and 
abnormal gait styles and cadences ranging from a slow shuffle to a fast walk.  The 
StepWatch has validated accuracy between 1 – 4 mph 1-29. When properly used, 
accuracy typically exceeds 98%. Contact modus technical support 
(support@modushealth.com) if your accuracy is notably lower.  
 
A body of published research demonstrates that functional differences in gait activity 
can be clearly and objectively measured with the StepWatch™ in a wide range of 
human (and large animal) populations. A bibliography listing of currently known 
publications is available at modushealth.com or contact research@modushealth.com. 
 
The StepWatch™ is listed with the US FDA as a class II exempt medical device.  

A. Care of the StepWatch™ Hardware 
The StepWatch™ 3 is designed to provide maintenance-free performance for the life of 
the product. With proper use and care, StepWatch™ 3 is limited only by the battery 
life, which is typically up to seven years. The StepWatch™ is warrantied against 
manufacturing defects for a period of two years from the date of purchase. If you 
need assistance with your StepWatch™, including warranty claims, contact 
support@modushealth.com.  
 
Temperature extremes, particularly high temperatures, will reduce battery life. Avoid 
leaving the StepWatch™ in hot places over 115 F. Maximum life is achieved at 
room/body temperature.  
 
WARNING!  NEVER PLACE THE STEPWATCH™ IN ANY TYPE OF OVEN OR 
AUTOCLAVE as this could potentially cause the permanent lithium battery 
to rupture or explode. 
 
The StepWatch™ is designed to withstand typical handling and real-life wear and tear. 
Factory calibration is permanent and won't change during normal use. However, the 
StepWatch™ is a sensitive instrument and should be treated with care and respect to 
maintain the highest possible accuracy. Extreme shock/vibration may affect the 
sensor threshold, which could decrease accuracy. For example, avoid severe drops 
onto concrete and putting the unit through a clothes washer or dryer cycle. 
 
The StepWatch™ 3 is water resistant but not waterproof. It should never be 
submersed or subjected to large quantities of water.  
 
Do not apply any covering (tape/stickers) or writing (marker/paint) to the 
front red cover of the StepWatch™. The StepWatch™ communicates with the 
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dock through the red cover and any obstruction could compromise the quality of 
recorded step data.  

1 . Cleaning and Sanitizing 
 The StepWatch™ is designed for multi-subject use. The StepWatch™ monitor may be 
cleaned using a cloth dampened with mild soap and water or 70% isopropyl alcohol. 
Strong detergents or solvents will damage the plastic and will void the warranty. 
NEVER soak the StepWatch™ in any type of cleaner or solvent. WARNING! NEVER 
PLACE THE STEPWATCH™ IN ANY TYPE OF OVEN OR AUTOCLAVE, as this 
may cause the battery to rupture or explode 
 
The docking station is NOT water resistant or waterproof. The StepWatch™ dock may 
be cleaned using a cloth dampened with mild soap and water or 70% isopropyl 
alcohol. Strong detergents or solvents may damage the plastic and will void the 
warranty. Do not soak the StepWatch™ Dock in any type of cleaner or solvent. NEVER 
PLACE THE STEPWATCH™ DOCK IN ANY TYPE OF OVEN OR AUTOCLAVE. 
  
The StepWatch™ straps and cuffs should be hand washed with mild soap and water, or 
a solution of 70% isopropyl alcohol. Do not use machine washing or drying, as this 
may cause shrinkage and hasten deterioration of the elastic. In highly infectious 
situations, the straps and cuffs should be only used on a single subject, and should be 
discarded after use. Contact modus to order new straps and cuffs at 
orders@modushealth.com  

2. Service and Repair 
The StepWatch™ and the StepWatch™ dock are not user-serviceable. Opening or 
tampering will void the warranty. Contact modus support 
(support@modushealth.com) for assistance with a StepWatch™ or StepWatch™ dock.  

3. Disposal 
This symbol on the product or on its packaging indicates that this 
product must not be disposed of with your other household waste. 
Instead, it is your responsibility to dispose of your waste equipment at a 
designated collection point for the recycling of waste electronic and 
electrical equipment. The “Li” designation on the symbol indicates the 
presence of a lithium battery. 
 
Lithium battery warning: Fire, explosion and burn hazard- do 
not short-circuit, recharge, incinerate, expose to temperatures 
above 212F, disassemble, puncture or expose contents to water. 
Dispose of the battery properly. 

 

B. Setting up the StepWatch™ Program and Data Files 
Follow the instructions included with your order for installing the software on your 
computer. StepWatch™ software version 3.1b for Windows XP and older versions and 
Mac OS 10.6 and older versions require a serial number for use. StepWatch™ software 
version 3.4+ for Windows 7 and newer and Mac OS X 10.7 and newer do not require a 
serial number. 
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If your StepWatch™ 3.1b serial number has been lost, you may use this serial number 
for all installations of 3.1b: 2026-EAEE-0C27-2A7A 

C. Using the Dock 
The StepWatch™ application should not be running when you plug in or 
unplug the StepWatch™ dock. 
 
To install the StepWatch™ dock, follow the installation procedures included with the 
dock or contact modus health support (support@modushealth.com) for help installing 
the dock.  
 
The StepWatch™ is placed on the dock face down (red side down) so that it fits into 
the indentation on the dock. 
 

 
 
The StepWatch™ dock features lights that indicate its communications status: 

• Fading blue light - The dock is plugged into the computer and has power. It 
is OK to unplug the dock in this state. 

• Steady Green and Blue Lights - The StepWatch™ desktop software is 
running and the correct USB port is selected in StepWatch™ software 
preferences so that the software can communicate with the dock. If the blue 
light is steady but the green light is not on, the correct port has not been 
selected. It is OK to remove or place a StepWatch™ on the dock is in this state 
but DO NOT unplug the dock until the StepWatch™ software is closed and the 
green light is off. 

• Steady Red and Blue Lights - There is a StepWatch™ on the dock and the 
dock is communicating with the StepWatch™ software DO NOT REMOVE 
THE STEPWATCH™ OR DAMAGE COULD RESULT. Wait until the green 
light comes on again before removing the StepWatch™. 

• Flashing Red and/or Blue lights - Error, see “Troubleshooting” later in this 
manual. 

 
The StepWatch™ 3 dock does not require external power. It draws power 
from the USB connection with the computer.

 

D. Setting Preferences 
Before you start to collect data, we recommend familiarizing yourself with each of the 
following preference options, because they affect how the data are recorded, displayed and 
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analyzed. You may change your preference settings by choosing “Preferences” from the 
“Edit” (Windows) or “StepWatch” (OS X) menu. 
 
Select either English or Metric units. This will affect both height measurements (inches or 
centimeters) and date formats (order of day and month, and characters separating day, 
month and year). The date format you choose should be the same as that used by your 
computer operating system. (The European date style may not display in all locations where 
dates appear.) 

1 . LED Flashes 
The StepWatch™ is equipped with a red diagnostic LED at the top of the unit to help you 
determine if the programmed settings are applicable to a given subject. The LED blinks each 
time a step is detected. You should use the LED flashes to quickly assess the appropriateness 
of your settings by watching your subject walk and ensuring that the light blinks once for 
each step. Be sure your subject does not try to look at the StepWatch™ while walking, 
because this creates an untypical gait pattern.  
By default, the LED is set to blink for the first 40 steps collected after programming. When 
using Advanced Programming, this preference is overridden by the number you specify on 
the programming screen. You may specify up to 255 LED blinks in Advanced Programming. 

2. Days to Record 
The “Days to Record” preference sets the default recording time for each monitoring session 
initiated with the regular programming mode. The “Recording” window provides an option to 
change the setting for a particular monitoring session. Unless downloaded earlier, the 
StepWatch™ will always run at least this number of days. You may want to set the 
StepWatch™ to record several days longer than your intended session.  In the event that your 
subject forgets to wear the monitor, the data collection session will then be automatically 
extended without the subject having to return the monitor for re-programming. 

3. Percent Time Active 
We recommend not changing this number from the default 35%. If you have extremely active 
or inactive subjects and  are trying to record for as long as possible, contact modus research 
support for further advice at research@modushealth.com. 

4. Auto-Exclude 
This function allows you to specify the days with relatively few or no steps that are to be 
automatically excluded from analysis. The function only applies when data are first 
downloaded. Editing the time selection for the day in the “Edit Time” window may later 
include auto-excluded days. 

5. Activity Level Definitions 
All step counts are based on the steps for the measured leg.  Steps can be doubled to 
estimate total steps on the left and right legs by checking “Double counts to estimate both 
legs” under Preferences. 
 
The values you associate with Low and Medium Activity will be the upper limit for those 
categories. For example, 15 for Low means that all intervals with 1 - 15 steps/minute will be 
counted as Low Activity, and the Medium category will begin at 16 steps/minute. The High 
value does not set an upper limit for High Activity. Instead, this number controls the scale of 
the y-axis for plotting of the step data on your screen and for printing. 
 
We strongly recommend deciding on your Activity Level definitions once and 
leaving your preferences at these values permanently . This will allow you to directly 
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compare results from different files and will reduce the potential for inconsistencies in your 
analyses and comparisons. 
 
Note on Activity Level Definitions: 
Our research with disabled populations has shown that 15 steps per minute on 
the measured leg for Low activity and 30 steps per minute on the measured leg  
for Medium activity were effective limits. With those definitions, time spent at 
medium level activity tended to be a very strong marker of functional 
differences. 
 
Our normative data collection on healthy persons has shown that activity limits of 15 steps 
per minute on the measured leg  for Low activity and 40 steps per minute on the measured 
leg  for Medium activity represented natural break points in the aggregate distributions of 
activity intensity. These definitions have also been effective in distinguishing between the U.S. 
DHHS “Healthy People 2010” descriptions of "moderate" and "vigorous" activities. Tudor-
Locke determined that a minimum of 50 steps on the measured leg per minute is equivalent 
to moderate intensity walking (i.e. 3 metabolic equivalents)30. Further research is needed to 
inform on the most appropriate categorization schemes for all situations. 

6. Display Options 
 The “Draw Grid Lines for Step Rates” option controls whether horizontal step rate grid lines 
are drawn in the daily step plots on your screen and in printing. The “Display Activity Level as 
Color Bands” option controls whether the color bands for Low and Moderate activity are 
shown in the step plots on your screen and in printing. These color bands can be helpful 
references for visual inspection of your data, but they can also be misperceived. When the 
line representing any data point passes through and beyond a given activity intensity band, 
that line is counted in the interval within which it peaks. When you change either of these 
settings, you will need to close and re-open any open files to see the effect. 

7. Communications 
Use the pop-up menu to specify the port into which you plugged the StepWatch™ dock. You 
may verify whether your selection is correct with the check dock function in the 
“Communications Test” of the Monitor menu or by verifying that the green light is illuminated 
on the dock. If the software does not detect the dock, contact modus support for assistance 
at support@modushealth.com  

8. Report Printing Notes 
In the “Preferences” window on the “Reports” tab you can customize the report title, report 
subtitle, and a report footer that will appear on pages printed from the StepWatch™ software. 

E. Programming the StepWatch™ 
There are two ways to program the StepWatch™ to record data: 

• Easy Start is accessed through the "Start Recording Activity" command in the 
Monitor menu. This option provides enough flexibility to set up the StepWatch™ 
appropriately for most subjects and applications, while protecting you from 
unexpected results. You control the StepWatch™ settings indirectly by describing the 
gait characteristics of your subject. We recommend you use this method unless 
you have an unusual application.  

 
To initiate “Easy Start” programming place the StepWatch™ face down on the dock 
and select “Start Recording Activity” from the “Monitor” menu. The software will read 
programming information from the StepWatch™ and the docking station will show a 
red light while it is communicating. DO NOT MOVE THE STEPWATCH™ WHILE 
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THE RED LIGHT IS ON. This will take a few seconds. The Start StepWatch™ screen 
will then appear. Complete the subject description. 

   
• Advanced Programming allows direct access to all StepWatch™ settings and 

accommodates unusual uses. Use this option only if you have thoroughly familiarized 
yourself with the settings and need more custom options than Easy Start provides. 
Carefully study instructions for using the Advanced options and consult with modus 
research (research@modushealth.com) if you have questions.  

 
Prior to programming you should confirm that you have set the preferences as you wish. (See 
“Setting Preferences” earlier in this manual.)   

1. Subject Description 

a. Height 
This setting strongly affects the maximum rate at which the StepWatch™ can identify steps. 
In general, a person's height is inversely related to step rate, meaning a taller person will often 
have a slower step rate than someone shorter. If you do not know your subject's height and 
you specify an incorrect value, the steps recorded may not be accurate. 

b. Quick Stepping 
 A key to accurately identifying quick stepping activities is to distinguish overall walking 
speed from how quickly steps are being taken. Some activities, such as fast walking with long 
strides, involve traversing the ground rapidly without taking steps much more quickly than 
moderate walking with shorter strides. Other activities, like vigorous dancing, involve moving 
the feet quickly without the body traversing the ground quickly. 
 
It is also important to distinguish activities the subject likes or knows how to do from those 
they are likely to undertake during the monitoring session. 
 
Indicating YES for the “Quick Stepping” setting has a fairly strong affect on the 
StepWatch™ performance. If you are uncertain, choose NO. If you are in question 
about whether an activity qualifies, have the subject "demonstrate their moves" and adjust 
accordingly.  
 
Examples of quick stepping activities might be: 

• Running or jogging with a short and/or rapid stride 
• Vigorously playing sports such as basketball, soccer, volleyball, racquetball, tennis 
• Jumping rope (with more than one jump per rope cycle) 
• Romping energetically with a child or dog 
• Fast dancing 
• "Spinning" on a bicycle 
• High-impact aerobics 

c. Walking Speed 
NOTE: Answering YES  to “Quick Stepping” overrides and disables this option. 
 
Evaluating a person's normal walking speed relative to their height may be an unfamiliar 
concept. The intent is to identify how quickly steps are being taken rather than the absolute 
speed at which a person traverses the ground. Comparing extremes in height helps illustrate 
the concept. Consider a small child, an average height mother, and a very tall father walking 
together at the same speed. If they are maintaining the mother's normal comfortable speed 
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(and all are unimpaired), the child would be walking quite quickly relative to his height, and 
the father would be walking slowly relative to his height. 
 
Apply that concept to your subject. For her height, is her normal walking speed slow, 
average, or fast? Most people will fall in the average category. 

d. Range of Speeds 
NOTE: Answering YES  to “Quick Stepping” overrides and disables this option. 
 
This setting influences how broad a range of step rates the StepWatch™ will "expect". For 
most people, a moderate range is appropriate. Some subjects, however, rarely change their 
walking speed because of habit, preference or, most commonly, physical limitations. It is more 
difficult to evaluate whether a person "regularly engages in both extremes". The following 
examples may help with the determination. Remember, a person must regularly exercise 
BOTH extremes to qualify. 
 
Examples of the slow extreme might be: 

• Walking with a slow-moving elderly person 
• Walking with a young child 
• Meandering, window shopping 
• Slow pacing with a long stride 

 
The key is to identify whether the person regularly walks such that the leg is in the swinging 
phase for a long time. 
 
Examples of the fast extreme might be: 

• Fast walking (e.g. for exercise or within a job that requires moving quickly through 
large spaces) 

• Jogging or running with a fairly long stride (Note: if a person regularly runs with a 
short rapid stride, the Quick Stepping designation will be YES and the Range question 
will not be relevant) 

• Bicycling with a moderately fast cadence 
• Exercising on a Stair Master 

 
NOTE: Bicycling appears to the StepWatch™ as walking. If a person regularly bicycles, they 
should remove the StepWatch™ during bicycling unless you would like their bicycling counts 
to be included in the gathered step data. If you choose to include the data, you may want to 
investigate how quickly they pedal – “spinning” versus moderate pedaling versus slow 
pedaling, for example – as the data gathered under these conditions may be affected by this 
setting. 

e. Leg Motion 
Observe how the subject moves in your presence. 
 
It is the motion at the leg and ankle that is most relevant, since that is what the StepWatch™ 
will be sensing. Look at the motion of their leg/ankle rather than their whole gait. 

• Dynamic/fidgety: If your subject is especially fidgety or tends toward quick, abrupt 
movements, use the "Fidgety and/or Dynamic" setting. Most children fall into this 
category. This setting may also be appropriate for people who are foot tappers, 
especially heel tappers. 

• Gentle/geriatric: If your subject moves very slowly or gently, use the "Gentle and/or 
Geriatric" setting. This designation may also be appropriate for people who regularly 
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undertake activities with subtle steps (usually in confined areas) if you are having 
trouble "capturing" those steps. Examples of those types of activities might be: 

- Working behind a counter or at a workbench 
- Dancing gently 
- Cooking in a small kitchen 

If you are unsure, program a monitor with the "Normal" setting and put it on the 
subject. Have them demonstrate their movements. Watch whether the StepWatch™ 
light blinks when they take steps. If you are regularly missing steps, try using the 
"Gentle and/or Geriatric" setting. 
 
Be careful about assuming a "Gentle and/or Geriatric" setting for persons who walk 
with a prosthesis, walker, cane or crutches. It is important to watch the motion of the 
leg in these cases. Often the leg swings forward fairly rapidly and a "Normal" setting is 
appropriate. "Normal" is also appropriate for older people whose ankle and leg motion 
is flexible. 

• Normal: Most people fall in the "normal" category. 

f. Recording Time and Notes 
Before initiating programming, you have the option of changing when the monitor will start 
and stop recording, as well as adding notes. Notes will be shown in the downloaded data file 
after a recording session and are useful for tracking a recording session across analysis 
facilities/different localities/etc. 

2. Initiate Programming 
When you are satisfied with your settings, click the Start button to initiate programming. 
Programming will take up to 30 seconds. When programming is completed, the red light on 
the docking station will no longer be illuminated and the green light on the docking station 
will illuminate. The software will present a window verifying when recording will start. You 
should now remove the StepWatch™ from the dock and attach it to the subject. By default, 
the StepWatch™ will not start recording steps until one minute after the 
“success” dialog window. This minimizes recording false steps from motions applied to 
the StepWatch™ during subject attachment. 

3. Verify the Settings 
Once the programming is completed, you may wish to confirm the appropriateness of your 
settings by watching the LED blink one time per step as your subject walks at their normal 
speed. You may also have them walk at the “slowest pace they would normally walk” and the 
“quickest pace they would normally walk.” Your subject should not look at the monitor while 
walking, as this will change their walking pattern. You should watch to see that the 
StepWatch™ is not double blinking on slow steps, and not blinking at all on fast steps. If you 
are walking with your subject, do not lead them or trail too far behind as this may influence 
their natural pace. If possible, stand still at the front, back or side and simply observe. 
 
Once a monitor has been programmed, do not double-check settings by reading 
recorded activity or reading current settings. Both of these actions will stop the 
recording and will put the StepWatch™ to sleep. No data will be logged until the 
monitor is reprogrammed. 
 
If you have programmed a monitor to start recording but it has not yet begun, 
do not try to read recorded activity until it has had time to record at least one 
interval. 
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If the StepWatch™ is not detecting steps as accurately as expected and attempts 
to adjust the Easy Start parameters do not help, review “Verify Cadence and 
Sensitivity Settings” in the  “Advanced Programming” section in this manual.  
 
The key to getting optimal results is balancing the Motion Sensitivity and the 
Cadence settings. For questions, contact modus for advice at 
research@modushealth.com. Virtually any gait style can be monitored accurately, 
but the difficult ones require more in-depth understanding of how the settings 
relate to each other and respond to particular gait styles. 

F. Wearing the Monitor 
• The StepWatch™ 3 should be worn on the outside or inside (medial or lateral) aspect 

of either leg just above the anklebone. Wearing on the outside is usually preferred. 
• The StepWatch™ must be worn over a sock or in a cuff and not directly on the skin. 

Cotton Lycra cuffs are available as an alternative to straps for attachment. Contact 
modus health to order straps and cuffs in various sizes at orders@modushealth.com 

• Be sure the StepWatch™ is oriented PROPER SIDE UP by observing the 
direction of the arrow on the label on the back of the device. It will not 
record data when it is upside-down. Take some time to instruct your subject 
about monitor orientation and to assure that they understand. This is also an 
opportune time to discuss where they will put the monitor when they take it off and 
what cues they will use to remember to put it on again. Being specific will facilitate 
compliance. 

• Should straps or cuffs become wet, they should be replaced with dry straps or cuffs as 
soon as possible and allowed to dry. The StepWatch™ is not waterproof. 

• Do not apply any covering or writing to the front red cover of the 
StepWatch™. 

II .  General Data Information 

A. Download Your Data 
Place the monitor face down on the dock and select “Read Recorded Activity” in the Monitor 
menu to download the data from your StepWatch™. This may take a few seconds to minutes 
depending on file size. 
 
Do not remove the monitor from the dock while it is communicating (while the 
red light on the dock is on). 
 
If you are unable to read a monitor see “Troubleshooting” in this manual. 
 
If you accidentally select "Start Recording Activity...” when you mean to read recorded 
activity, allow the communications to continue until the start StepWatch™ screen appears, 
then click cancel. Your data will not be compromised. Read the monitor again. 

B. View Your Data 
 When the data have been read you will see 4 tabbed windows. 

• “SUMMARY” includes the monitor ID, notes you entered, the time the monitor was 
programmed, started, and read, a list of days the monitor was running, other 
information pertaining to monitor settings, and a graphical representation of the data 
for each recorded day. 
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• “EDIT TIME” graphically shows minute-by-minute step plots of each day and allows 
you to select the time that will be included in your analysis. Double click on any day to 
access tools for including or excluding the day, or parts of the day, in your analysis. 

• “ACTIVITY LEVELS” show analyses involving low, medium, and high activity levels 
based on step rate (cadence). 

• “PERFORMANCE” shows analyses involving the highest step per minute cadences 
achieved for various durations of activity. 

C. Representations of the Step Data 

1. Graphical Representations of the Data 
There are several tools providing graphical representations of the data. For a more complete 
understanding of the analysis calculations see “Analysis Variables and Calculations” in this 
manual. 

a. Daily Step Plots  
Daily Step Plots show the raw data for each day with time (on 24 hour clock) across the 
bottom, and steps per minute on the vertical axis. Each small vertical line is one minute (if you 
have recorded in one minute intervals). The data represent step counts only for the leg being 
monitored. For an estimate of steps on both legs, multiply step counts by 2.  This is done 
automatically when “Double counts to estimate both legs” is checked on the Presentation tab 
under Preferences. If “Double counts to estimate both legs” is checked after the StepWatch™ 
file was downloaded. The StepWatch™ file must be saved, closed, and reopened for the 
Preference changes to take effect. 

b. Pie Charts  
Two types of pie charts on the Activity Levels window may be used to compare a chosen day 
to the average for the included time in your data file. One shows the percentage of time 
spent at high, moderate, and low activity (and inactive if selected) for both the average of all 
included time and the included time on a selected day. The other shows the percentage of 
steps taken at high, medium, and low levels of activity during the included time. 

c. Bar Charts  
Bar charts in the Activity Levels window provide the option of showing minutes or steps for 
all of the days during the monitoring session at any combination of high, medium, or low 
activity levels. If you click on a day at the top of the page, the outline of the bar graph 
associated with that day will be bolded.  

d. Sustained and Peak Activity Chart  
The Sustained Activity Chart on the Performance window shows graduated bars for the 
highest activity level sustained for continuous periods of 1, 5, 20, 30 and 60 minutes each 
day, and the line graph shows the peak activity index which is the average of the highest 30 
minutes of the day regardless of when they occurred (i.e. no requirement for continuity). The 
plots show the average for the entire monitoring period as well as each individual day. These 
measures are further described in the “Activity Time Calculations” in the “Analysis Variables 
and Calculations” section. 

e. Spreadsheets 
See “Export Data” on page 21 for descriptions of using spreadsheets. 

D. Filtering Data for Analysis 
To specify which data you want included in your analysis, click on the “Edit Time” tab of your 
data file. This shows a step plot for each day recorded with time (on a 24 hour clock) along 
the bottom and steps per minute on the vertical axis. Each data line indicates the number of 
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steps taken in 1 minute (1 minute is the default, you may have chosen different interval 
settings). If you are using the “Auto Exclude” option in “Preferences” you may see that some 
days are excluded already. 

1. Shift Time 
You may use the “Shift Time” function under “Monitor Utilities” to move data from one day to 
another. Shifting time allows you to adjust the starting time of a file by whole hours in either 
direction. For example, if you have a person whose activity runs past midnight, and you want 
to use their continuous “waking hours” as the basis for your statistics, you can shift the data 
to accommodate this. 
 
“Shift Time” removes any existing editing of included time. If you are matching 
data to a log you may wish to save a copy of the unshifted file while you are 
lining up time with the data. 

2. Change Included Time 
To change the time that is included or excluded in your analysis, double click on any day in 
the “Edit Time” window. An editing time window will open where you may alter the time that 
is included in a variety of ways: 

a. Start/Stop Bars 
Use your cursor to drag the “Start Time” and “Stop Time” bars across the plotted data. If you 
do not see these bars, they are at both ends of your plotted data. Move the cursor to either 
end until it becomes an " I " shape. Hold the mouse button down and drag. Release the button 
when the bar is in the desired location. You can use the digital time controls for fine 
adjustments. 

b. Digital Time Controls 
Use the digital time controls by clicking on the hour or minutes indicator for the start or stop 
time, then click on the arrows to the right of the numbers to control the number. 

c. Include/Exclude Day 
Click the "Include Entire Day" or "Exclude This Day" to achieve the desired result. 

d. Include/Exclude Range 
Use the “Include Range” or “Exclude Range” toggle buttons to control whether the time 
between your “Start” and “Stop Time” bars is included or excluded for analysis. 

e. Reset to Original 
Use the "Reset to Times Recorded” button to reset the day to the original state. This can be 
especially useful for partial days at the beginning and the end of a recording session. 

f. Make All Days the Same 
The "Make All Days the Same" check box applies the time selection for the day being edited 
to all the days in your file. This function can save time (and clicking). 
 
When you are satisfied with your time selection, click the OK button. 
 
Partial Days: Be aware that your average statistics for percent time at the 
various activity levels and percent time inactive are referenced to your included 
minutes (total time at each level for all days divided by total included minutes 
for all days). If you are not including entire days or the same amount of time for 
each day, these results can be misleading. 
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E. Analysis Variables and Calculations 
All step counts are for the measured leg unless changed in “Preferences” to double count as 
an estimate of both legs. Counts should be doubled for direct comparison to standard 
pedometer representations. To have the StepWatch™ software automatically double step 
counts for you, choose “Preferences” from either the “StepWatch” menu (OS X) or “Tools” 
menu (Windows). Click on the “Presentation” tab and click the box for “Double counts to 
estimate both legs”. Restart the software and re-open the file or re-read the StepWatch™ 
monitor. Note: The software will now always show doubled step counts. To set the software 
back to single counts, uncheck the setting and restart the software. 

1 .  Averages 
All averages are based on the whole and partial days you have chosen to include for analysis. 
Days that are entirely excluded will appear in italicized text in your analysis windows, but will 
not be included in the averages. 

a. Average Step Total 
This is the average step total of all included days regardless of whether parts of the days are 
excluded. If you are only including entire days, this average will be the same as the “Average 
Included Steps”. Days that are entirely excluded are not included in this calculation. For days 
in which some time is excluded, the entire step count for the day is included in this 
calculation. 

b. Average Included Steps 
This is the daily average of the steps taken during all included time. It is the sum of all 
included steps divided by the number of whole or partial included days. 

c. Average Minutes at None, Low, Medium and High Activity 
These variables reflect the percentage time spent at each activity level during the included 
time relative to the total included time. The percentages are calculated using the total 
minutes accumulated at each level divided by the total included minutes for all days. They are 
not the numeric averages of the percentage for each day relative to the included minutes for 
that day. 

d. Average Steps at Low, Medium and High Activity 
These measures are the average steps per day accumulated at each activity level for all 
included time. 
 
Designations for Low, Medium and High Activity Levels: If you change your 
presentation preferences for the divisions between activity levels, your statistics 
will automatically be re-calculated once you re-open a data file. 

2. Activity Level Calculations 
Note: To sort your days by any measure, click on the title bar for that measure in the statistics 
table in the “Activity Level” window. 

a. Step Total (Total) 
Total number of steps in the day regardless of whether any or all of the day is excluded. 

b. Minutes Included (Min. Incl.) 
Total number of minutes in the day included for analysis. 

c. Steps Included (Included) 
Total number of steps in the time included for analysis. 



15 

69906-001 Rev. A 8/20/2014   

d. Minutes Active (Min. Act.) 
Total minutes of the time included for analysis with at least one step per minute. 

e. Minutes Inactive (Min. Inact.) 
Total minutes of the time included for analysis in which no steps were recorded. 

f. Percent Inactive (%Time Inact.) 
Percent time of the day included for analysis in which no steps were recorded. 

g. Minutes Low (Min. Low) 
Total minutes of the time included for analysis with a Low Activity step rate.  Low Activity 
step rate is user-definable in Preferences but default is 1 to 15 steps per minute on the 
measured leg.  

h. Steps Low (Low) 
Total number of steps in the time included for analysis taken at a Low Activity step rate.  Low 
Activity step rate is user-definable in Preferences but default is 1 to 15 steps per minute on the 
measured leg.   

i .  Percent Steps Low (%Low) 
Percent of steps relative to all steps in the time included for analysis taken at a Low Activity 
step rate.  Low Activity step rate is user-definable in Preferences but default is 1 to 15 steps 
per minute on the measured leg. 

j .  Percent All Time Low (%TimeLow) 
Percent time included for analysis taken at a Low Activity step rate.  Low Activity step rate is 
user-definable in Preferences but default is 1 to 15 steps per minute on the measured leg. 

k. Percent Active Time Low (%Active Low) 
Percent of Low Activity relative to the total active time (at least 1 step per minute) included 
for analysis. Low Activity step rate is user-definable in Preferences but default is 1 to 15 steps 
per minute on the measured leg.   

l .  Minutes Medium (Min. Med) 
Total minutes of the time included for analysis with a Medium Activity step rate.  Medium 
Activity step rate is user-definable in Preferences but default is 16 to 40 steps per minute on 
the measured leg. 

m. Steps Medium (Med) 
Total number of steps in the time included for analysis taken at a Medium Activity step rate.  
Medium Activity step rate is user-definable in Preferences but default is 16 to 40 steps per 
minute on the measured leg. 

n. Percent Steps Medium (%Med) 
Percent of steps relative to all steps in the time included for analysis taken at a Medium 
Activity step rate.  Medium Activity step rate is user-definable in Preferences but default is 16 
to 40 steps per minute on the measured leg.   

o. Percent All Time Medium (%Time Med) 
Percent time included for analysis taken at a Medium Activity step rate.  Medium Activity step 
rate is user-definable in Preferences but default is 16 to 40 steps on the measured leg per 
minute.   
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p. Percent Active Time Medium (%Active Med) 
Percent of Medium Activity step rate relative to all active time (at least 1 step per minute) 
included for analysis.  Medium Activity step rate is user-definable in Preferences but default is 
16 to 40 steps per minute on the measured leg.   

q. Minutes High (Min. High) 
Total minutes of the time included for analysis with a High Activity step rate.  High Activity 
step rate is user-definable in Preferences but default is 41 steps per minute or greater on the 
measured leg. 

r. Steps High (High) 
Total minutes of the time included for analysis with a High Activity step rate.  High Activity 
step rate is user-definable in Preferences but default is 41 steps per minute or greater on the 
measured leg. 

s. Percent Steps High (%High) 
Percent of steps relative to all steps in the time included for analysis taken at a High Activity 
step rate.  High Activity step rate is user-definable but default is 41 steps per minute or 
greater on the measured leg. 

t. Percent All Time High (%Time High) 
Percent time included for analysis taken at a High Activity step rate.  High Activity step rate is 
user-definable in Preferences but default is 41 steps per minute or greater on the measured 
leg. 

u. Percent Active Time High (%Active High) 
Percent of time at High Activity step rate relative to all active time (at least 1 step per 
minute).  High Activity step rate is user-definable in Preferences but default is 41 steps per 
minute or greater on the measured leg. 
 

3. Performance Calculations 

a. Sustained Activity Measures: Max 1, Max 5, Max 20, Max 30, Max 60 
Each of these measures is derived by scanning the included time of a day with a "window" of 
the designated width (1, 5, 20, 30 or 60 minutes) and extracting the maximum number of 
steps achieved at any continuous interval of that duration. That maximum is then divided by 
the duration of the interval to give the average steps per minute of that best performance. 
 
For example, for the 60-minute sustained activity calculation, the steps between 12:00 AM 
and 1:00 AM are summed. Then the steps between 12:01 AM and 1:01 AM are summed. That 
process is continued for the entire day (or entire included time). The maximum sum is divided 
by 60 to give the average of the highest sustained 60-minutes for the day. 
 
MaxSteps60 (Max 60) – Average steps per minute on the measured leg of the most intensive 
60 continuous minutes of the included time in a day.  

  
MaxSteps30 (Max 30) - Average steps per minute on the measured leg of the most intensive 
30 continuous minutes of the included time in a day.   
 
MaxSteps20 (Max 20) - Average steps per minute on the measured leg of the most intensive 
20 continuous minutes of the included time in a day.   
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MaxSteps5 (Max 5) - Average steps per minute on the measured leg of the most intensive 5 
continuous minutes of the included time in a day.   
 
MaxSteps1 (Max 1) – Highest number of steps per minute on the measured leg during the 
included time in a day. 
 

b. Peak Activity Index: Best 30 Minutes 
 The Peak Activity Index (PeakPerf in exported stats) represents the average step per minute 
rate of the highest 30 minutes of the included time in a day, regardless of when they 
occurred. They may be scattered across the day. This differs from the Sustained Activity 
Measures that represent continuous blocks of time. 
 
To sort your days by any measure, click on the title bar for that measure in your 
statistics table. 

4. Handling Data Files 

a. Save and Save As 
The “Save” command under the File menu allows you to save step data to a file on your 
computer and to save alterations to a file already existing on your computer. If the file does 
not already exist on your hard disk (i.e. the data have just been read from the StepWatch™), a 
window will open that allows you to name the file and choose where to save it. If you are 
saving a file that you have opened from your computer, you will not be asked to name or 
choose the location for the file. 
 
The “Save As” command under the file menu allows you to name and choose the location for 
saving a data file on your hard disk. This allows you to assign a new name to a data set. This is 
useful, for instance, if you have changed the time included for analysis and want to preserve 
both the old and new versions. 
 
With either “Save” or “Save As”, the specifications for the time you have chosen to include or 
exclude for analysis will be saved with the file. The excluded data will not be lost and will be 
available for inclusion later. 

b. Opening and Closing Files. 
• Open: The Open command allows you to open a data file created by any 3-series 

(3.x) version of the StepWatch™ software. 
On Windows, all files in a directory which end with .swb will show up in the list of 
StepWatch™ Document file types showing in your Open dialog box. If you have 
StepWatch™ files which do not have the .swb extension, you may need to select "All 
Files" from the File Type pop-up menu in your Open screen. This is not typical. 

• Open Recent: The Open Recent command allows you to quickly access any of the 
last 5 data files that were saved. The Open Recent functions clears its history when 
changing Preferences or closing the program. 

• Import Data: The Import Data command allows you to import tab-separated “.xls” 
spreadsheet data files exported from 3-series (3.x) versions of the StepWatch™ 
software. Once a file is imported, you may use the Save or Save As… commands to 
store the file in the StepWatch™ Document format. The Import command will not open 
database records or files made with the Save Raw File command in older versions of 
the StepWatch™ software. 
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• Close: The Close command closes the currently focused data window. If the window 
contains changes that have not been saved, you will be asked whether you want to 
save the file before closing. 

c. Moving Data and Analyses to Other Software 
StepWatch™ software exports: Data are exported from the StepWatch™ software as a tab-
delimited file but saved with a “.xls” extension so they’re easily recognized by common 
spreadsheet software such as Excel. When adding calculations and formulas to an exported 
data file it’s very important to “Save-as” and save the file as the native spreadsheet software 
type to preserve your work. Calculations and formulas will not be saved if you use 
the tab-delimited format of a StepWatch™ export fi le.        

• Export Data: Step data may be exported to a tab-separated “.xls” spreadsheet using 
the Export Data option from the File menu. The first 27 rows of the exported file 
contain the StepWatch™ set-up and recording information. Row 24 indicates which 
data intervals were included for analysis using the convention: [include or exclude 
indicator]*[starting interval]*[ending interval]. The Include indicator is "i" and the 
Exclude indicator is "x." The counting is referenced to the first interval after midnight. 
(That interval is 1). The raw step data starts at row 28 and is divided into columns by 
day. The first column is time. You may use these files to perform custom analyses. 
Exported data files may later be imported back into the StepWatch™ 
program if the first 27 rows are unchanged. 

• Export Graph: The currently focused graph is saved to a .png graphics file in 
your choice of location. For example, if you select this option while on the Summary 
tab of the StepWatch™ data file, the summary graphs will be exported. If you switch to 
the Activity Levels tab, the activity levels graphs will be exported.  

• Export Stats: All data and analyses on the Activity Levels tab are exported to a tab-
separated “.xls” spreadsheet. The first 29 rows of the exported file contain the 
StepWatch™ set-up and recording information. 

• Copy Text: Currently highlighted text and data may be copied out of the 
StepWatch™ software selecting Copy Text in the Edit menu or using a standard copy 
keyboard shortcut. After you have copied the text, simply use the paste command in 
another application to transfer your data into that program. 

• Copy Graph: You may copy the charts and graphs from the “Summary”, “Activity 
Levels”, and “Performance” screens by selecting the Copy Graph option in the “Edit” 
menu. It will copy the image that is showing. You may paste it into any application 
with compatible graphics support. 

d. Printing Reports 
• Page Setup: The Page Setup command under the File menu gives the standard page 

set up options applicable for your chosen printer driver. Note: on some Windows 
machines, your page margins may need to be set at zero for printing to work properly. 

• Print Preview and Print: Most of the information visible in the downloaded 
StepWatch™ file may be printed. A one-week summary report can also be selected. 
Both the Print and Print Preview commands in the File menu allow you to specify 
which days of data to print, the number of charts to include per page, and the type of 
text or graphical data (e.g. Statistics, Daily Step Plots, etc.). You must choose at least 
one data type. 
Prior to initiating the Print Preview, we recommend you check your Page Setup 
settings. If you want to use different page setups for printing the different data types 
for a file, you will need to select those data types in separate Print Preview or Print 
sessions, and modify your Page Setup between sessions. If you are using a computer 
running Windows, and your previewed or printed pages seem clipped at the edges, 
use the Page Setup to set all four margins to zero. There is a Presentation settings tab 
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in the Preferences section (under the “StepWatch” menu on OS X or “Tools” menu on 
Windows) which allow you to control whether the colored bands designating low, 
medium, and high activity levels and the horizontal grid lines are shown on step plots 
as well as a field to customize text in the print footer. 

I I I .  About the StepWatch™ Database 
The StepWatch™ database has been removed from version 3.4. We recommend maintaining a 
version of StepWatch™ 3.1b to continue using the database or migrating your database data 
back to StepWatch™ Document (.swb) files for use in version 3.4.  

IV. Batch StepWatch™ File Processing 
This function automatically exports StepWatch™ raw data files into spreadsheets and 
combines analysis results of clients into one spreadsheet.  Under the “File” menu select 
“Batch Processing”.  Select the folder that contains all of the StepWatch .swb files to export 
into raw data files or export into one analysis file.  You may review each StepWatch file 
graphically before proceeding to one of the export functions. 
 
The Export Raw Data selection will provide a tab delimited data file for each StepWatch file.  
The Export Analyses selection will provide one tab delimited data file with the daily 
StepWatch metrics for each client for each day included in the analysis.  

V. Overview of Advanced Programming 
You have the option to manually specify your StepWatch™ settings using the “Advanced 
Programming” mode. This can be accessed through the “Utilities” portion of the Monitor 
menu. The StepWatch™ monitor must be in the dock to start advanced 
programming.  
 
Advanced Programming should only be used if you are experienced with the StepWatch™. 
The Advanced Programming mode gives you direct access to the many StepWatch™ settings 
and allows you to customize its response for unusual subjects or applications in ways not 
permitted by the regular Easy Start mode. If you use the Advanced Programming mode 
without understanding the controls, you can program the StepWatch™ to behave in 
unintended ways. This will not hurt the StepWatch™, but could reduce the quality of your 
data. 
 
When you launch “Advanced Programming”, the settings currently stored in the StepWatch™ 
memory will be read and displayed. You may alter any of these settings within limits. If you 
are unsure whether your choices are appropriate, you can click the "Reset to Defaults" button 
to return the settings to their default state. When you are satisfied with your settings, click 
the “Start” button to initiate programming. Note: No matter how the StepWatch™ settings are 
modified/programmed with Advanced Programming, if you return to the regular “Start”, the 
settings always begin as the default for Easy Start. Advanced Settings do not change the 
regular defaults. 

A. Sensitivity 
The Sensitivity and the Cadence are the most important settings for customizing 
your StepWatch™ to the gait style of any subject. The “Sensitivity” determines how 
much movement is necessary for a step to be detected. The setting is dependent both on the 
mechanics of the subject’s gait and the particular threshold level of each individual monitor.  
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The “Sensitivity” setting is based on the individual calibration value for each StepWatch™. You 
can view the calibrated threshold on the advanced 
programming screen in the box labeled 
“Calibration”. The calibrated threshold value is a 
number between 1.050-1.140.  
 
Because of the natural variation in the 
calibrated threshold of each StepWatch™ monitor, the same sensitivity setting 
will have different results on the performance of each StepWatch™ monitor and 
must be set specific to each StepWatch™ monitor’s calibrated threshold value. 
The specific values of all other Advanced Programming settings give consistent results 
between monitors. 
 
The following table gives you the recommended sensitivity ranges based on calibrated 
threshold, but you may want to try settings outside of these recommendations for unusual 
gait styles. It is important to remember that RAISING the numerical value of the 
Sensitivity setting makes the StepWatch™ LESS SENSITIVE to movement. 
 

SUGGESTED SENSITIVITY SETTINGS BASED on THRESHOLD VALUES 
Calibrated Threshold Suggested Setting Setting Range 

1.05 16 12 to 20 
1.06 15 11 to 19 
1.07 14 10 to 18 
1.08 13 9 to 17 
1.09 12 8 to 16 
1.10 11 7 to 15 
1.11 10 6 to 14 
1.12 9  5 to 13 
1.13 8 4 to 12 
1.14 7 3 to 11 

B. Cadence 
The “Cadence” effectively limits how quickly steps can be detected and helps you avoid 
double counting steps. The “Cadence” is set in increments of 1/100ths of a second. 
RAISING the numerical value of the “Cadence” will LOWER the maximum rate at which steps 
can be detected. So the higher the “Cadence” number, the less often it will be ready to count 
a new step. The “Cadence” value should be set as high as is possible without missing steps at 
your subject's most rapid stepping pace. 
 
Normal values for adults are 60 - 80. Values toward the higher numbers are appropriate for 
people who take steps very slowly or who have long legs; values toward the lower numbers 
are appropriate for people who take steps quickly or have short legs. Children without 
disability are often in the 40 - 60 range. 
  
To find out what the normal cadence is for a particular height, program the 
monitor with quick start at that height and all settings at normal. After it starts 
to run, read the monitor then start it with advanced programming. The cadence 
shown will be the cadence for a person of that height with normal gait and 
normal walking speeds. 



21 

69906-001 Rev. A 8/20/2014   

C. Other Advanced Programming Settings 

1. Mode 
 The StepWatch™ operates in three different modes: sleep, record, and test. Through 
“Advanced Programming”, you can explicitly set it to any of the states. The “Advanced 
Programming” screen will always open with “Record” set as the default. Do not change this 
except under the guidance of StepWatch™ support personnel. 

2. Interval 
 This setting determines how frequently step counts are recorded. The recording interval 
(epoch) is set in seconds with options ranging from 3 to 180. We strongly recommend 
using 60 (1 minute) for long-term monitoring sessions. One-minute intervals will 
allow you to directly compare your data with that collected by others using this standard unit. 
StepWatch™ units can generally collect up to 50 days of data at 1-minute intervals.  
 
You may wish to use shorter intervals for accuracy trials. 

3. Count Scaling 
This is a simple multiplicative compression scheme which allows you to record numbers 
larger than 255 per recording interval (epoch). The “Count Scaling” should normally be left at 
1. If you use 1-minute intervals, you won't need to use “Count Scaling” because your step 
counts will not exceed 255 per epoch. If you use intervals greater than 2 minutes, you may 
want to use a “Count Scaling” greater than 1. 

4. Data Compression 
This should be kept “ON” because it extends your maximum monitoring time and it reduces 
the demand on your StepWatch™ battery. It allows the monitor to use less recording space 
for inactive time. Do not change this except under the guidance of StepWatch™ support 
personnel. 

5. Days to Record 
The maximum possible days to record are determined by the interval and the percent time 
active set in Preferences. By default, a 60 second interval results in up to 50 days of possible 
recording time. See further description in “Setting Preferences” in this manual. 

6. LED Flashes 
In “Advanced Programming” you specifically set the number of initial LED flashes each time 
you program the monitor. The number set in preferences is ignored. For a further description 
see “Setting Preferences” in this manual. 

7. Battery 
You can see an estimate of a monitor’s remaining percent battery life in the Calibration field. 
(This information is also available in “Read Current Settings” under the Utilities menu and on 
the “Summary” page of every downloaded file). 

8. Start Time and Notes 
In “Advanced Programming” you are able to set the start time for now or later, but not later in 
another time zone. You may also enter notes that will appear in the data file on the 
“Summary” window. When you are satisfied with your settings click the “Start” button. 

D. Verify Cadence and Sensitivity Settings 
Be sure that you have specified an adequate number of starting LED flashes for the following 
procedures. You should check that your settings work correctly with each subject by having 
them walk at their normal pace while you observe the starting LED blinks.  The StepWatch™ 
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should blink once with each stride. If the StepWatch™ is not responding appropriately, such 
as double-blinking during a stride or not blinking with a stride, observe the response to the 
following two conditions and re-adjust settings accordingly: 
 

1 . Have your subject walk at the slowest pace they would ever normally  walk.  
Watch the StepWatch™ light to see that steps are not being double counted. If you are 
seeing double counts you have two options: 

• Increase your Cadence value, or  
• If your subject has very dynamic motion at the ankle and utilizes a wide range of 

cadences, RAISE the numerical value of the Sensitivity setting while keeping the 
Cadence value small enough to accurately capture fast cadences. 

2. Have your subject walk at the fastest pace they would ever normally walk.  
Watch the light to see that steps are not being missed. If you see missed steps or if you 
notice that the light tends to blink at different points in the gait cycle during consecutive 
steps (which may make you feel uncertain about what you have observed) you have two 
options: 

• You can lower the Cadence value and try again, or 
• If your subject has unusually gentle motion at the ankle (like with shuffling gait), 

you may need to LOWER the numerical value of the Sensitivity setting to avoid 
missing steps. 

 
Be sure your subject does not try to look at the blinking light for this will cause them to walk 
with a distorted gait. If they routinely run or do other quickly stepping activities, you may 
want to have them demonstrate the activity so you can evaluate the performance of the 
monitor by watching the light blink or by doing an accuracy trial (see below). 
  
Be sure your subject understands that the LED will not be flashing during their 
monitoring session. If your subject expects the monitor to flash, they may 
assume it is not working when they do not see flashes and decide not to wear it.  

E. Accuracy Trials 
If you want to conduct accuracy trials, you may wish to use a recording interval of 10 to 15 
seconds rather than 1 minute because, to locate your accuracy trial in the exported data, you 
need to have zeros in the file before and after the trial. When using a recording interval of 10 
or 15 for an accuracy trial, note the time you begin and have your subject sit or stand still for 
30 seconds or more immediately before and immediately after the accuracy trial. The trial will 
thus be sandwiched by zeros that will allow you to locate it and match up the manual step 
counts. During accuracy trials, it is helpful to have two observers both using hand held tally 
counters (available in office supply stores). Having two observers with hand-held counters 
allows them to talk casually with the subject, thus reducing gait changes due to self-
consciousness; it also lessens the effect of observer counting errors. 
 
During the trial, LED flashes should be set to a minimal number so the StepWatch™ does not 
cue observers’ counts. Have the subject walk at his/her normal pace in an unobstructed area, 
with the observers walking alongside or following. Be sure the observers are counting only 
when the leg wearing the StepWatch™ takes a step (rather than when steps are taken with 
each leg.) It takes some practice to count accurately because an observer's own walking 
cadence can interfere with counting the subject's steps. If your accuracy trials are short, any 
error by the observers will result in a relatively large misrepresentation of the StepWatch™ 
accuracy. 
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When the trial is completed, download the data and export it to a spreadsheet file using the 
"Export Data" command in the “File” menu. Open the file in your spreadsheet program. Scroll 
down to the time at which you conducted the trial. If your subject stood still for an adequate 
time before and after the trial, the walking trial will appear as a string of similar values with 
zeros immediately before and after. Average the observers' manual counts and compare with 
the StepWatch™ count. 
  
If you are conducting accuracy trials but wish to use the cadence and sensitivity 
settings as determined for your subject by the Easy Start functions, program the 
monitor using Easy Start. Wait one minute and read the monitor. Note the 
sensitivity and cadence settings displayed under StepWatch™ Settings.  
Reprogram the StepWatch™ with advanced start using the Easy Start sensitivity 
and cadence values and your desired Interval and LED flashes. 

VI. Troubleshooting 
The StepWatch™ program provides some tools to assist in troubleshooting including 
messages during the program operation and several diagnostic tools in the menu. Contact 
modus support for further technical assistance at support@modushealth.com 

A. Communications Errors 
A properly connected StepWatch™ 3 dock has a green light illuminated when the 
StepWatch™ software is open. If you do not see this light, are not able to read your 
StepWatch™, or if the red and blue lights are flashing on your StepWatch™ 3 dock: 

• Check the connections between the dock and the computer. Try plugging the dock 
into another USB port on the computer. 

• Verify that your Communications Preferences have the correct port specified: Choose 
“Preferences” from either the Tools menu (Windows) or the StepWatch menu (OS X) 
and then click on the “Communications” tab. Click the “Set to Default Values” button, 
followed by pulling down the “Connect to StepWatch dock via” menu and selecting 
the entry for “StepWatch Dock” (Windows) or “usbserial-NNNNNN“ (OS X). Then click 
the “Done” button. The green light on the StepWatch™ dock should now be 
illuminated. 

• Verify that the computer can communicate with the dock and the StepWatch™ by 
using the “Communications Test” below. 

• Make sure the StepWatch™ is properly aligned on the dock. 
• Make sure there are no bright lights shining on the StepWatch™. Halogen lights can be 

especially troublesome. The infrared lights of some motion analysis systems also make 
shielding necessary. 

B. Communications Test 
You may use the Communications Test (in the “Tools” menu) to check that your 
communications preferences and hardware are set up correctly and the StepWatch™ 
software is able to "talk to" the docking station and StepWatch™. 

• Click the "Check Dock" button to verify that your computer is in communication with 
the docking station. You do not need to have a StepWatch™ on the dock to do this. 

• You may click the “Check StepWatch™“ button to verify that your StepWatch™ is 
properly communicating. The “Advanced Settings” should only be used with guidance 
from modus technical support. 

C. Read StepWatch™ Settings 
Use the “Read Settings and Put to Sleep” option in the “Utilities” section of the “Monitor” 
menu to quickly verify the settings in your StepWatch™ memory. Use this test on a 
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StepWatch™ that is asleep or has not recorded any data. Do not use this to verify the settings 
after you have programmed a monitor, as it will stop the monitor from recording. This 
function is intended to provide a means for conveniently checking the settings or notes in the 
memory of a monitor not in use. You can also use it to verify that a StepWatch™ is asleep and 
see the threshold calibration. 
 
Alternatively, use the “Read and Restart with Previous Settings” option to read the 
StepWatch™ monitor memory settings and reprogram it with the current settings. This is 
useful to double check the settings of a monitor which was just set to record and set it back 
into the recording state with those settings instead of putting it to sleep. Do not perform 
this test on a monitor which has recorded data, the data WILL be lost. 
 
Caution: Always wait 60 seconds before reading a monitor which was just set to 
record. 

D. View Communications Log 
The Communications Log keeps a record of each time you program and download a 
StepWatch™. 	
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Appendix A: Hardware Specifications 

A. StepWatch™ 3 Activity Monitor Specifications 
Size     75 x 50 x 20 mm 
Weight    38 grams 
Battery    750mAh Lithium 
Battery Life    Up to 7 years depending on use 
Accuracy    >98% independently validated 
Sensitivity    User adjustable via software 
Housing    Injection molded polycarbonate 
Attachment    Highest accuracy at ankle, Velcro strap or cotton Lycra cuff 
Recording Time   Up to 50 days minimum at 60 second resolution 
Resolution    1 minute is standard, user adjustable from 3-180 seconds 
Memory    32KB, includes 64-character user notes field 
Temperature    Operating 0º to 50ºC / Storage: -20º to 70ºC 
Shock / Drop  Avoid severe shocks and drops 
Tamperproof    Permanently sealed 
Water resistant   Yes 
Waterproof   No 
Factory refurbishable  No 
FDA    Listed with the FDA as a class II exempt medical device 

B. StepWatch™ 3 Dock Specifications 
Size     106 x 68 x 31 mm 
Weight    150 Grams 
Communication   USB to computer, IR to StepWatch™ 
Batteries    Not required 
LED status indicators  3 
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Contact Information 
 
  
 

modus health, llc 
1054 31st Street NW 

Suite 318 
Washington, DC 20007 

202.830.1100 
 

To order StepWatch™ units and supplies: orders@modushealth.com 
For StepWatch™ technical support: support@modushealth.com 

For assistance with using your StepWatch™ in practice: research@modushealth.com 
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